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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan
pengguna sebelum menggunakan monitor.
Panduan tersebut berisi informasi dan catatan
penting tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan
tanggal pembelian, nama dealer, nomor model,
dan nomor produksi produk.

1.1 Tindakan pencegahan dan
pemeliharaan

) Peringatan

Penggunaan kontrol, penyesuaian, maupun
prosedur selain yang dijelaskan dalam
dokumentasi ini dapat mengakibatkan sengatan
listrik, bahaya listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer.

Pengoperasian

* Jauhkan monitor dari sinar matahari
langsung, cahaya yang sangat terang, dan
sumber panas lainnya. Pemaparan dalam
waktu lama terhadap jenis lingkungan
tersebut dapat mengakibatkan perubahan
warna dan kerusakan pada monitor.

* Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.

* Jangan halangi lubang ventilasi pada kabinet.

* Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.

* Jika mematikan monitor dengan melepaskan
kabel daya atau kabel daya DC, tunggu
selama 6 detik sebelum memasang

kabel daya atau kabel daya DC untuk
pengoperasian biasa.

* Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak
ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

* Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya
selama pengoperasian berlangsung.

* Jaga agar monitor tidak terjatuh atau
terbentur selama pengoperasian atau
pengiriman.

Pemeliharaan

e Untuk melindungi monitor dari
kemungkinan kerusakan, jangan letakkan
benda berat di atas panel LCD. Saat
memindahkan monitor, pegang bingkal
untuk mengangkat, jangan angkat monitor
dengan meletakkan tangan atau jari pada
panel LCD.

* Lepas sambungan monitor jika Anda tidak
akan menggunakannya dalam waktu lama.

* Lepas sambungan monitor jika Anda
akan membersihkannya dengan kain yang
lembab. Layar dapat dibersihkan dengan
kain yang kering saat dimatikan. Namun,
jangan pernah gunakan larutan organik,
seperti alkohol atau cairan beramonia untuk
membersihkan monitor.

*  Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air,
maupun berada dalam lingkungan dengan
kelembaban berlebihan.

* Jika monitor basah, segera seka dengan kain
kering.

» Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas
kabel daya. Setelah itu, keluarkan benda
asing atau air tersebut, lalu bawa ke pusat
pemeliharaan.

* Jangan simpan atau gunakan monitor di
lokasi yang bersuhu panas, terkena sinar
matahari langsung, atau bersuhu sangat
dingin.

*  Untuk memelihara performa terbaik
monitor dan memperpanjang masa



pakainya, gunakan monitor di lokasi dalam
kisaran suhu dan kelembaban berikut.
. Suhu: 0-40°C 32-95°F

. Kelembaban: 20-80% RH

Informasi penting untuk Efek Terbakar/
Bayangan Gambar

» Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala
Jjika monitor akan menampilkan konten
statis yang tidak berubah. Tampilan gambar
diam atau gambar statis yang tidak berubah
dalam waktu lama dapat menimbulkan “efek
terbakar”, disebut juga “jejak gambar” atau
“bayangan”, di layar.

"Efek terbakar", "jejak gambar”, atau
"bayangan" adalah fenomena umum dalam
teknologi panel LCD. Dalam sebagian besar
kasus, “efek terbakar”, “jejak gambar”,

atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

) Peringatan

Kegagalan mengaktifkan screensaver, atau aplikasi
refresh layar secara berkala dapat menyebabkan
gejala parah "efek terbakar", "jejak gambar”, atau
bayangan gambar" yang tidak akan menghilang
dan tidak dapat diperbaiki. Kerusakan yang

disebutkan di atas tidak tercakup dalam jaminan
Anda.

Layanan

* Penutup casing hanya dapat dibuka oleh
teknisi ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

* Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

€& Catatan

Hubungi teknisi servis jika monitor tidak
beroperasi secara normal atau Anda tidak yakin
dengan prosedur yang harus dilakukan bila

petunjuk pengoperasian yang diberikan telah
diikuti.



1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian,
atau peringatan yang digunakan sebagai berikut:

& Catatan

lkon ini menunjukkan informasi penting dan
tips yang akan membantu Anda memanfaatkan
sistem komputer dengan lebih baik.

@ Perhatian

lkon ini menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

) Peringatan

lkon ini menunjukkan kemungkinan cedera
dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam
format lain dan mungkin tidak disertai dengan
lkon. Dalam hal ini, penulisan peringatan tertentu
diwajibkan oleh peraturan pemerintah terkait.

1.3 Pembuangan produk dan materi
kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.
Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.



Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Memasang monitor

2.1 Pemasangan

Kl Isi kemasan

murs  sss00

Quick

Start

PHILIPS

onitor
user's manual
. PHILIPS O
\
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2 Memasang dudukan dasar

—_

Letakkan monitor menghadap ke bawah
pada permukaan yang halus dan lembut
agar layar tidak tergores atau rusak.

2. Pasang batang dudukan ke monitor hingga
terdengar bunyi klik pada posisinya.

3. Pegang dudukan dasar monitor dengan
kedua tangan dan masukkan dudukan dasar
dengan kuat ke dalam batang dudukan.

DVI (opsional)



H Menyambungkan ke PC

PHILIPS

@ nput daya AC
© InputVGA
© nput DVI-D (tersedia untuk model tertentu)
@ Input audio (tersedia untuk model tertentu)
© Kunci antipencurian Kensington

Menyambung ke PC

1. Sambungkan kabel daya dengan kuat ke
bagian belakang monitor.

w N

Sambungkan kabel sinyal monitor ke
konektor video di bagian belakang
komputer.

4. Sambungkan kabel daya komputer dan
monitor ke stopkontak di sekitar.

5. Hidupkan komputer dan monitor. Jika
monitor menampilkan gambar, berarti
pemasangan telah selesai.

Matikan komputer dan lepas kabel daya.

2.2 Mengoperasikan monitor

1 Keterangan produk bagian depan

\ ‘ PHILIPS ‘ ccoo00

: —
Model 226V4LA:
(5]
AUTO/ W 1 /A 0-/4 /0K Q)
© © 06 o o

Model 226VA4L:

(5]

AUTO/V  [D/A 0-/4 /0K Q)

| A |
(7 6 0 6 o (1

Menghidupkan dan mematikan

|
o O daya monitor.
Mengakses menu OSD.
® S/0K Konfirmasikan penyesuaian OSD.
Kembali ke tingkat OSD
o < sebelumnya.
(4 O-  |Sesuaikan tingkat kecerahan.
© | A ¥V Menyesuaikan menu OSD.

i Menyesuaikan volume suara
speaker.

®

[ |Ubah format tampilan.

Secara otomatis menyesuaikan
@ AUTO /

monitor,




2. Memasang monitor

2. Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-
Screen Display)?

OSD (On-Screen Display) adalah fitur yang
terdapat pada semua monitor LCD Philips.
Pengguna akhir dapat menggunakannya untuk
menyesuaikan performa layar atau memilih fungsi
monitor secara langsung melalui jendela petunjuk
di layar. Antarmuka tampilan di layar yang mudah
digunakan muncul seperti di bawah ini:

Model 226V4LA:

1 VGA
&= Input :

= VGA ’
&= Input -

Petunjuk dasar dan mudah pada tombol kontrol

Pada OSD yang ditampilkan di atas, Anda
dapat menekan tombol ¥ A pada bezel depan
monitor untuk menggerakkan kursor, lalu tekan
tombol OK untuk mengonfirmasikan pilihan
atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari
struktur On-Screen Display. Anda dapat
menggunakannya sebagai referensi bila ingin
melakukan penyesuaian lainnya nanti.

Main menu Sub menu

VGA
Input I:

DVI
(available for selective models)

r— Picture Format —
Picture

— Brightness -
— Contrast —

— SmartContrast —_—

— Stand-Alone —
Audio

— Mute -

(available for selective models)

Color Temperature —

Wide Screen, 4:3
0~100

0~100

On, Off

On, Off

On, Off

6500K, 9300K

Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
Language — English . Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, TEIfRHISE, Tirkge

— Horizontal i
OSD Settings
—— Vertical —
— Transparency -

— OSD Time Out -

Setup — Auto

— H. Position
— V. Position
— Phase
— Clock

— Resolution Notification

— Reset

L Information

0~100
0~100
Off, 1,2, 3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off

— Yes, No



El Pemberitahuan resolusi

Monitor ini dirancang untuk memberikan
performa optimal pada resolusi aslinya,

yakni 1920 x 1080 pada 60 Hz. Bila monitor
dihidupkan pada resolusi yang berbeda, layar
akan menampilkan peringatan: Gunakan 1920 x
1080 pada 60 Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat
dinonaktifkan dari Setup (Konfigurasi) dalam
menu OSD (Tampilan di Layar).

4] Fungsi Fisik

Kemiringan

2.3 Melepas Dudukan dan Dudukan
Dasar

1 Melepas Dudukan Dasar

Sebelum mulai membongkar penyangga
monitor, ikuti petunjuk di bawah ini agar
terhindar dan kemungkinan kerusakan atau
cedera.

1. Letakkan monitor menghadap ke bawah
pada permukaan yang halus agar layar tidak
tergores atau rusak.

2. Tekan klip pengunci untuk melepas dudukan
dasar dari batang dudukan.

3. Tekan tombol pelepas untuk melepas
batang dudukan.




& Note

This monitor accepts a T00mm x 100mm VESA-
Compliant mounting interface.




3. Pengoptimalan Gambar

3.1 SmartContrast

E} Apakah yang dimaksud dengan
SmartContrast?
Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor LCD
untuk kejernihan visual dan kenyamanan
tampilan maksimal dengan menambah cahaya
lampu latar agar gambar lebih jernih, tajam,
dan terang, atau mengurangi cahaya lampu
latar untuk tampilan gambar yang jelas di latar
belakang gelap.

E3 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap
jenis konten. SmartContrast secara dinamis
mengontrol kontras dan menyesuaikan cahaya
lampu latar agar gambar dalam permainan
serta video lebih jernih, tajam, dan terang, atau
menampilkan teks yang jelas dan mudah dibaca
untuk pekerjaan kantor. Dengan mengurangi
pemakaian daya monitor, Anda menghemat
biaya untuk daya dan memperpanjang masa
pakal monitor.

E} Bagaimana prosedurnya?

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time

untuk menyesuaikan warna dan mengontrol
intensitas cahaya lampu latar. Fungsi ini akan
secara dinamis menyempurnakan kontras

untuk pengalaman hiburan yang luar biasa saat
menonton video atau menjalankan permainan.

3.2 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol
monitor melalui antarmuka grafis layar

yang mudah digunakan. Penyesuaian rumit
sebelumnya kini tidak ada lagi karena panduan
perangkat lunak yang mudah digunakan ini
akan memandu Anda menyesuaikan resolusi
penyempurnaan, Kalibrasi warna, Pengaturan
jam/fase, Pengaturan titik putih RGB, dsb.

10

Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis Ikon animasi
yang menarik dan mendukung Windows 7/

ini siap menyempurnakan pengalaman Anda
menggunakan monitor Philips!

E} Penginstalan

PHILIPS

lkuti petunjuk dan selesaikan penginstalan.

Anda dapat mengaktifkannya setelah
penginstalan selesal.

Jika ingin mengaktifkannya di lain waktu,
Anda dapat mengklik cara pintas di desktop
atau toolbar.

www.philips.com/welcome

Monitor driver and software installation
System requirements:
+ PC runming Windows 7, Vism, XP, 2000, 98

» Go to wewphilips.com/welcome o downlead the latest version of manitor driver

Philips SmartControl
System wpport and requirements:
1. System support Windows 7, Vista, XP,

L Language support English, German, Spanish, French, ltalian, Russian, Portuguese. Simpified Chinese
3. Philips Monicor Plug and Play support

Wizard pengaktifan pertama kali

Setelah penginstalan SmartControl Lite
selesai, Wizard pengaktifan pertama kali
akan terbuka secara otomatis.

Wizard ini akan memandu Anda
menyesuaikan performa monitor secara
bertahap.

Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

Anda dapat menyesuaikan pilihan lainnya
tanpa menggunakan wizard melalui panel
Standard (Standar).



3. Pengoptimalan Gamb

Ed Memulai dengan panel Standard (Standar):

B smartControl

SmartControl Lite

Adiust Audio

Auto Pivot

T
Input

Wizard

2
Presets

o

Multi Monitors

2 - Philps 225B1 (C530715000001) |3)(X

PHILIPS

Wizard

You'l need to calbrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves 2 series of steps that wil let you
tune your display and save the settings.

1. Choose the Start Wizard button.

2. Follow the steps outiined in this process.

3. Save your settings for future use.

Start Wizard

Menu Adjust (Penyesuaian):

Menu Adjust (Penyesuaian) digunakan

untuk menyesuaikan Brightness (Kecerahan),

Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

Cancel (Batal) mengkonfirmasi pengguna
jika ingin membatalkan penginstalan.

B SmartControl

SmartControl Lite

o

Color an
-

Resolution

Help

2 - Philps 225B1 (C530715000001) 7| X,

PHILIPS

Brightness

Improperly adjusted Brightness wil resuft in a loss of
detailin darker image areas. Adjust the Brightness for
the best possble picture qualty.
1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Brightness

i
&=

Undo Reset

11

B smartcontrol

SmartControl Lite

Adjust Y
. Brightness
\g Contrast
Color R
~
i Focus
2 +
E
r Position

options ',‘;

g Resolution

Help

" W SmartControl

SmartControl Lite

Adjust o
()
Brightness
D Contrast
Color %
e Focus
o Y
Position
Options FF
Resolution
Help
" W SmartControl
SmartControl Lite
7‘2
Brightness
Contrast
Focus

Options ’F

g Resolution

Help

2 - Phiips 22581 (€S30715000001) {F}X

PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais in
lighter image areas.
1. Raise the Contrast until the numbers 1 and 2
are no longer visble.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

Contrast 50

Undo Reset

2 - Philips 22581 (€S30715000001) z X
PHILIPS

Focus

Your display’s timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visible, you'l need

o adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

pitch 50
— ~ v’
Phase 17
g0 &
Undo Auto Setup
2 - Philps 22581 (cs30715000001) %1%
Position

Use the Pesition buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
horzontally.
Undo Reset
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e

B SmartControl
SmartControl Lite
Adiust Q
o
Contrast
Color
=
a Position
Options
Resolution
.HeTD
“

Menu Color (Warna):

*  Menu Color (Warma) digunakan untuk
menyesuaikan RGB, Black Level (Tingkat
Hitam), White Point (Titik Putih), Color
Calibration (Kalibrasi Warna).

* Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

*  Untuk item submenu berdasarkan input
Anda, lihat tabel di bawah ini.

* Misalnya Color Calibration (Kalibrasi
Warna).

18 smartControl 2 - Phiips 22581 (C530715000001) __‘?_“5

SmartControl Lite PHILIPS
Black Level
Improperly adjusted Black Level wil result in 2 lass of
detailin darker image areas. Adjust the Black Level for
the best possible picture guality.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.
RGB
§ Red 50
Black Level = ® +
Green 50
White Paint: = @ +
Blue 50
Display Gamma o o &
g Undo Reset
Calibration o
Help

rane )
2 - Philips 22581 (Cs30715000001) [F] %)

PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.

If your display is at a Non-Preferred resolution, click
on the Preferred button to change your resolution to
Prefarred.

™ Enable Resolution Notifier

Picture Format
™ 4:3 aspect ratio

Preferred

12

8 smartcontrol

SmartControl Lite

W

RGB
BIa(!( Level
Whle Point

s
Display Gamma
LA
Options Callbration
.
Help

{8 smartControl

SmartControl Lite

W

RGB

B!a:!( Level

Color White Point

Display Gamma

L

Calibration

(2
W SmartControl

SmartControl Lite

w

Adjust RGB

- - l'l
Black Level

Color White Point

Display Gamma

Calibration

Help

2 - Philips 22581 (CS30715000001) 5??5'

il

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at fullintenstty create
white, This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.
1. Please select the White Point value for the best
possble color quality.

White Point B500K
= Q +

Undo Reset

2 - phiips 22581 (C530715000001) ()X '

PHILIPS

Display Gamma

Gamma is 2 component of the pixel brightness in a
display. A lower Gamma value praduces brighter pixels
and a higher Gamma value produces darker pixels. The
default value for Gamma is 2.2.

To adjust Gamma, SmartImage must be set to Off.
Click the SmartImage Off button before adjusting
Gamma.

1. Use the slider to select the desired Gamma.

Display Gamma 2
= o &
Smartimage OFf
Undo Reset

. )
2 - Philps 22581 (Cs30715000001) (] %)

PHILIPS

Calibration

Your display needs to be properly calibrated in order
for it to produce the widest range of colors accurately.
Calibration should always take place as the fast tuning
step in the process. Remember to recalibrate any time
you make individual adjustments to image quality or
whenever you move your display to a new location.

. Make al other necessary adjustments to image
quality first.

. Press Show Me to learn how to use the
calibration tools.

. Finally, press Start to begin the calibration
process.

¥ Enable color calibration

Color software designed in collaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,053

Show Me Start

Quick View
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1.

2.

"Show Me" (Tunjukkan) memulai tutorial
kalibrasi warna.

Start (Mulai) - memulai urutan kalibrasi
warna 6 langkah.

Quick View (Tampilan Ringkas) memuat
gambar sebelum/sesudah kalibrasi.

Untuk kembali ke panel awal Color
(Warna), klik tombol Cancel (Batal).
Enable color calibration (Aktifkan kalibrasi
warna) - telah diaktifkan secara default.
Jika tidak dicentang, kalibrasi warna tidak
dapat dijalankan serta tombol start (mulai)
dan quick view (tampilan ringkas) akan
dinonaktifkan.

Info paten harus ditampilkan di layar
kalibrasi.

Layar Kalibrasi warna pertama:

Tombol Previous (Sebelumnya)
dinonaktifkan hingga layar kalibrasi warna
kedua ditampilkan.

Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

Layar terakhir menampilkan panel
File>Presets (File>Preset).

Cancel (Batal) menutup antarmuka
pengguna dan kembali ke halaman plug in.
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Options>Preferences (Pilihan>Preferensi) -
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options

(Pl

ihan). Di layar yang tidak didukung, namun

dilengkapi DDC/CI, hanya tab Help (Bantuan)
dan Options (Pilihan) yang tersedia.

8 smartcontrol

S

2 - Philips 22581 (CS30715000001) i X ]

martControl Lite PHILIPS

Preferences

wing options ta configure

Q en right-clicking on desktop
U Preferences
udio

Adjust Al
X‘ Auto Pivot
e
Color Input
s
=B 1
Wizard
2
Options Presats
cur

Q s

Help

Menampilkan pengaturan preferensi saat ini.

Jika kotak dicentang, fitur akan diaktifkan.
Kotak centang berfungsi sebagai pengunci.

Enable Context Menu (Aktifkan Menu
Konteks) di desktop dicentang (Aktif)
secara default. Enable Context Menu
(Aktifkan Menu Konteks) menampilkan
pilihan Select Preset (Pilih Preset) dan
Tune Display (Sempurnakan Layar) untuk
SmartControl Lite dalam menu konteks klik
kanan di desktop. Disabled (Dinonaktifkan)
menghapus SmartControl Lite darni menu
konteks klik kanan tersebut.

lkon Enable Task Tray (Aktifkan Baki
Tugas) dicentang (Aktif) secara default.
Enable Context Menu (Aktifkan menu
konteks) menampilkan menu baki tugas
untuk SmartControl Lite. Mengklik kanan
ikon baki tugas akan menampilkan pilihan
menu Help (Bantuan), Technical Support
(Dukungan Teknis), Check for Update
(Periksa Pembaruan), About (Tentang), dan
Exit (Keluar). Bila Enable Task Tray menu
(Aktifkan menu baki tugas) dinonaktifkan,
ikon baki tugas hanya akan menampilkan
EXIT (KELUAR).



3. Pengoptimalan Gambar

* Run at Startup (Jalankan Saat Pengaktifan)
dicentang (Aktif) secara default. Bila
dinonaktifkan, SmartControl Lite tidak akan
berjalan saat pengaktifan atau tidak akan
ditampilkan dalam baki tugas. Satu-satunya
cara menjalankan SmartControl Lite
adalah melalui cara pintas desktop atau file
program. Preset apapun yang ditetapkan
untuk berjalan saat pengaktifan tidak
akan dimuat bila kotak ini tidak dicentang
(Dinonaktifkan).

* Enable transparency mode (Aktifkan mode
transparansi) (Windows 7/, Vista, XP). Nilali
default adalah 0% Tidak Tembus Cahaya.

Options>Input (Pilihan>Input) - Hanya
diaktifkan sewaktu memilih Input dari menu

drop-down Options (Pilihan). Di layar yang tidak

didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia. Semua tab SmartControl Lite lainnya
tidak tersedia.

2 - Philps 22581 (CS30715000001) {¥)|X,

PHILIPS

" I SmartControl
SmartControl Lite

Input

Your display has two inputs (connections on back of
this disply) so you can haok up two different sources
at the same time. Use the Analog In and Digital In
buttons to select which source you'd like to view. You
are currently viewing the analog in image.

§

IMPORTANT! If you switch inputs SmartControl may
lose the ability to control your monitor. In this case you
may have to use the Input Select button on the front
of your monitor to switch back to the original input
before SmartControl functionality can be restored.

Adijust Audio

D Auto Pivot
Color Input
.
\Q Wizard
s -
Options Prasets

Multi Monitors

Help

Analog In Digital In

*  Menampilkan panel petunjuk Source
(Sumber) dan pengaturan sumber input
saat ini.

* Dilayar input tunggal, panel ini tidak akan
ditampilkan.
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Options>Audio (Pilihan>Audio) - Hanya
diaktifkan sewaktu memilih Audio dar menu
drop-down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi
DDC/CI, hanya tab Help (Bantuan) dan Options
(Pilihan) yang tersedia.

2 - Phiips 22581 (€S30715000001) | 7)(X,

PHILIPS

B smartcontrol
SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Turn off the integrated loudspeakers by checking the
Mute checkbox.

™ Mute
Adjust Audio

&

u Auto Pivot
-
Color Input
\,
) 1
@ o
, 2
Options Presets
\g Mutti Monitors
Volume 100
Help = o
Undo

Help>User Manual (Bantuan>Panduan
Pengguna) - Hanya diaktifkan sewaktu memilih
User Manual (Panduan Pengguna) dari menu
drop-down Help (Bantuan). Di layar yang tidak
didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia.

2 - Philips 22581 (C€S30715000001) |2,

PHILIPS

B SmartControl
SmartControl Lite

User Manual

If you need help setting up or operating SmartContral,
click the Tech. Support button. You'l have the
option to fil out an Assistance Form.

You can alsa choose to have information abaut your
software automaticaly attached to the assistance
form. You'll need to be online to use this feature.

&

Adjust g
Use lanual

Z
S\ @i
§®

Color
b
o Display D
gt
. System ID
Options
&
Version

&

User Manual Tech. Support




3. Pengoptimalan Gambar

Help>Version (Bantuan>Versi) - Hanya
diaktifkan sewaktu memilih Version (Versi) dari
menu drop- down Help (Bantuan). Di layar
yang tidak didukung, namun dilengkapi DDC/CI,
hanya tab Help (Bantuan) dan Options (Pilihan)
yang tersedia.

B smartControl 2 - Philps 225B1 (CS30715000001) {%)(X)
SmartControl Lite PHILIPS

Version

SmartControl

Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

DDC/CI Communication: Yes - ATI2 APT

Copyright © 1993-2009 Portratt Displays, Inc.

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuai
Konteks) diaktifkan secara default. Jika Enable
Context Menu (Aktifkan Menu Konteks) telah
dicentang dalam panel Options>Preferences
(Pilihan>Preferensi), menu tersebut akan
ditampilkan.

@ SmartControl
Select Preset 4
Tune Display

Context Menu (Menu Konteks) memiliki tiga
entri:

*  SmartControl Lite - Bila dipilih, About
(Tentang) Layar akan ditampilkan.

» Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu. Tanda centang
menunjukkan preset yang saat ini dipilih.
Preset Pabrik juga dapat dipilih dari menu
drop down.

* Tune Display (Sempurnakan Layar) -
Membuka panel kontrol SmartControl Lite.

Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.

Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

* Help (Bantuan) - Mengakses file User
Manual (Panduan Pengguna): Buka file User
Manual (Panduan Pengguna) menggunakan
jendela browser default.

* Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.

*  Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

» About (Tentang) - Menampilkan informasi
rinci tentang referensi: versi produk,
informasi edisi, dan nama produk.

*  Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan
ulang sistem.

PHILIPS

SmartControl

SmartControl
Version 3.20
dtune-standard-R2007-01-04-1151-23
Copyright 1993-2007 Portrait Displays, Inc.
Patents Pending




3. Pengoptimalan Gambar

Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas,
nonaktifkan Run at Startup (Jalankan Saat
Pengaktifan) dalam Options>Preferences
(Pilihan>Preferensi).

& Catatan

Semua ilustrasi pada bagian ini hanya sebagai
rujukan. Versi software SmartControl mungkin
berubah tanpa pemberitahuan. Silakan periksa
situs web resmi Portrait di www.portrait.com/
dtune/phl/enu/index untuk mengunduh versi
terbaru software SmartControl.
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4. Spesifikasi Teknis

Jenis panel LCD

LCD TFT
Lampu latar LED
Ukuran panel 215" P (54.6 cm)
Rasio aspek 16:9
Jarak Piksel 0,248 x 0,248 mm
Kecerahan 250 cd/m? or 200 cd/m?
SmartContrast 10,000,000:1

Rasio kontras (biasa)

1000:1 or 600:1 for 200 nit or 3000:1 for MVA panel

Waktu respons (biasa)

5 ms or 25ms for MVA panel

Resolusi Optimum

1920 x 1080 @ 60Hz

Sudut pandang

170° (H) /160° (V) @ C/R > 10
or 90° (H) / 65° (V) @ C/R > 10 for 200 nit
or178° (H) /178° (V) @ C/R > 10 for MVA panel

Input sinyal

Wamna layar 16,7/M
Kecepatan refresh vertikal 56Hz - 76Hz
Frekuensi Horizontal 30kHz - 83kHz
sRGB YA

DVI-D (digital)(opsional), VGA (Analog)

Sinyal Input

Kenyamanan

Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

Kenyamanan Pengguna

226V4ALA:  auTo/w (/A -/« /0K 0]
226V4L: auTo/Y  EN/A 0/ <4 /0K O]

Bahasa OSD

Inggris, Prancis, Jerman, Italia, Rusia, Spanyol, China Modem, Portugis,
Turki

Kenyamanan lainnya

Kunci Kensington

Kompatibilitas Plug & Play

DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac OSX, Linux

Dud
Kemiringan -5/+20
226VA4LA:
Daya
Mode Aktif 21,45 W (standar), 25,65 W (maks.)
Tidur (Siaga) 0,5W
Tidak Aktif 0,5W
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz
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226VA4L:

Mode Aktif 21,5 W (standar), 23 W (maks.)
or 20,5 W (standar), 23,71 W (maks.) for 200 nit
or 23,6 W (standar), 27,82 W (maks.) for MVA panel
Tidur (Siaga) 0,5W
Tidak Aktif 0,5W
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Produk dengan dudukan
(PxLxT)

514 x 388 x 213 mm

Produk tanpa dudukan
(PxLxT)

Produk dengan dudukan

514 x 320 x 48 mm

3.34kg
Produk tanpa dudukan 3.00kg
Produk dengan kemasan 4.5%g
Kisaran suhu (beroperasi) 0°C hingga 40°C

Kisaran suhu (tidak

-20°C hingga 60°C

Kesesuaian dan standar
Pengesahan Peraturan

Warna

beroperasi)

Kelembaban relatif 20% hingga 80%

MTBF 30.000 jam

ROHS YA

EPEAT Silver (www.epeat.net)
Kemasan 100% dapat didaur ulang
Bahan Kimia Khusus Rangka 00% bebas PVC BFR
Energy Star YA

Penandaan CE, FCC Kelas B, GOST, SEMKQO, Bersertifikasi TCO (Only
for selective models), UL/cUL, 1SO9241-307,BSMI

Hitam atau Putih

Lapisan Luar

Mengkilap/Bertekstur

& Catatan

1. EPEAT Gold atau Silver hanya berlaku di lokasi tempat produk Philips terdaftar. Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

2. Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi
terbaru, kunjungi www.philips.com/support.
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4.1 Mode Resolusi & Preset

E} Resolusi Maksimum
1920 x 1080 pada 60 Hz (input analog)
1920 x 1080 pada 60 Hz (input digital)

E3 Resolusi yang Disarankan
1920 x 1080 pada 60 Hz (input digital)

Frek. H. (kHz) Resolusi Frek. V. (Hz)
3147 720 x 400 70.09
3147 640 x 480 59.94
35.00 640 x 480 66.67
37.86 640 x 480 72.81
37.50 640 x 480 75.00
37.88 800 x 600 60.32
46.88 800 x 600 75.00
48.36 1024 x 768 60.00
60.02 1024 x 768 75.03
44.77 1280 x 720 59.86
63.89 1280 x 1024 60.02
7998 1280 x 1024 75.03
55.94 1440 x 900 59.89
70.64 1440 x 900 7498
65.29 1680 x 1050 59.95
67.50 1920 x 1080 60.00

& Catatan

Perlu diketahui bahwa layar Anda akan berfungsi
sempurna dengan resolusi asli 1920 x 1080
pada 60Hz. Untuk mendapatkan kualitas
tampilan sempurna, ikuti saran resolusi ini.



5. Manajemen Daya

Jika PC dilengkapi perangkat lunak yang

terinstal atau kartu tampilan yang terpasang
sesuai dengan DPM VESA, monitor secara
otomatis dapat mengurangi pemakaian daya
saat tidak digunakan. Jika terdapat input dari
keyboard, mouse, atau perangkat input lainnya
yang terdeteksi, monitor akan 'bangun’ secara
otomatis. Tabel berikut menunjukkan pemakaian
daya dan pemberian sinyal dari fitur hemat daya
otomatis ini:

226VALA:
Ketentuan Manajemen Daya
Mode Vid Sinkronisasi | Sinkronisasi Daya yang Warna
VESA | "'9%© | horizontal | vertikal Digunakan LED
Aktif [ AKTIF Ya Ya 21,45W (standar) Putih
) TIDAK ) ) Putih
Tidur AKTIF Tidak Tidak 0,5W (standar) (berkedip)
; TIDAK TIDAK
Matikan AKTIE - - 0,5W (standar) AKTIE
226VAL:
Ketentuan Manajemen Daya
Mode Video Sinkronisasi| Sinkronisasi Daya yang Warna
VESA horizontal vertikal Digunakan LED
21,5W (standar)
or 20,5W
(standar) for 200
Aktif | AKTIF Ya Ya nit Putih
or236W
(standar.)for MVA
panel
: TIDAK : 2 Putih
Tidur AKTIF Tidak Tidak 0,5W (standar) (berkedip)
: TIDAK TIDAK
Matikan AKTIF - - 0,5W (standar) AKTIF

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor.

* Resolusi asli: 1920 x 1080

Kontras: 50%

*  Kecerahan: 250 nit or 200 nit

*  Suhu warna: 6.500k dengan pola putih
sepenuhnya

& Catatan
Informasi ini dapat berubah tanpa
pemberitahuan sebelumnya.
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6. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery

& and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
iIndependent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

» Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

* Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
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halogenated substances and hazardous
flame retardants

* Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

*  Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

* Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable IT goals. We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



I[u Technology for you and the planet
CERTIFIED

(Only for selective models)

EPEAT

(www.epeat.net)

%  The EPEAT (Electronic

00 y P .

roduct Environmental

“ON Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on

51 environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

«  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

»  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

« 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

« TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turming the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

» Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de l'article
15 Des régles de la FCC. Ces limites sont
congues de fagcon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Clags A of EN 55022 (radivs of protection up to 30 meters). The ussr of the
device is obliged to take all staps necessary to remove sources of intarfarance o tala-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedenao, #2 spada do do ffidy A podis EN 55022,
spadd automaticky do tidy B podie EN 55022, Pro zafizen! zatazend do tFidy A (chranné
pésrmo 30m) podie EN 55022 platl nésledulicd. Dojde-l k rullenl telekormunikatnich nebo
Fnfich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rueni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIIEE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il 5 Abs. 4 der Rontgenverordnung erfillt
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgeflhrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUR LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



/. Layanan pelanggan dan
jaminan

7.1 Kebijakan Cacat Piksel Monitor
Panel Datar Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel LCD TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindani. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuai
dengan jaminan yang berlaku. Pemberitahuan

Ini menjelaskan berbagai jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel LCD TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah
cacat subpiksel pada monitor tidak boleh

lebih dari 0,0004%. Philips bahkan selanjutnya
menentukan standar kualitas lebih tinggi untuk
jenis atau kombinasi cacat piksel tertentu yang
lebih nyata dibandingkan dengan yang lainnya.
Kebijakan ini berlaku secara global.

4 N

Subpiksel Subpiksel Subpiksel

v
piksel
o

)

Piksel dan Subpiksel

Piksel, atau elemen gambar; terdiri dari tiga
subpiksel dalam warna utama merah, hijau,
dan biru. Kombinasi beberapa piksel akan
membentuk gambar: Bila semua subpiksel pada
piksel menyala, kombinasi ketiga subpiksel
berwarna tersebut akan muncul sebagai satu
piksel putih. Bila semua mati, kombinasi ketiga
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subpiksel berwarna akan muncul sebagai satu
piksel hitam. Kombinasi lainnya dari subpiksel
yang menyala dan mati akan muncul sebagai satu
piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan

pola gelap. Berikut adalah jenis cacat titik terang:

4 N

o v

Satu subpiksel merah, hijau, atau biru terang

4 N

| ¢

o %

Dua subpiksel terang yang berdekatan:
- Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

o v

Tiga subpiksel terang yang berdekatan (satu



piksel putih)

© Catatan

Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih
terang daripada titik di sekitarnya.

Cacat Titik Gelap

Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,
titik gelap merupakan subpiksel yang terlihat
jelas di layar bila monitor menampilkan pola

terang. Berikut adalah jenis cacat titik gelap:

4 N

4 I N
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CACAT TITIK TERANG

Jarak Cacat Piksel

Karena cacat piksel dan subpiksel sejenis yang
saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak

cacat piksel.
s R
a N
- /
. J

Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel LCD TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

TINGKAT YANG DAPAT DITERIMA

1 subpiksel terang 3
2 subpiksel terang yang berdekatan 1
3 subpiksel terang yang berdekatan (satu piksel putih) 0
Jarak di antara dua cacat titik terang* >15mm
Total cacat titik terang dari semua jenis 3

CACAT TITIK GELAP
1 subpiksel gelap

TINGKAT YANG DAPAT DITERIMA
5 atau lebih sedikit

2 subpiksel gelap yang berdekatan

2 atau lebih sedikit

3 subpiksel gelap yang berdekatan

0

Jarak di antara dua cacat titik gelap*

>15mm

Total cacat titik gelap dari semua jenis

5 atau lebih sedikit

TOTAL CACAT TITIK

Total cacat titik terang atau titik gelap dari semua jenis

TINGKAT YANG DAPAT DITERIMA
5 atau lebih sedikit

& Catatan

1. 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
2. Monitor ini sesuai dengan ISO 9241-307. (1509241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)

W

1ISO9241-307 adalah pengganti standar ISO13406 yang sebelumnya dikenal, setelah ditarik oleh

International Organisation for Standardisation (ISO) sejak tanggal 13-11-2008.




7.2 Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs Web www.philips.com/support. Anda juga dapat menghubungi nomor
Pusat Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara ASC Nomor layanan konsumen  Harga
Germany Siemens I&S +49 01803 386 853 € 0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call taniff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call taniff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call taniff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call taniff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens I&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call taniff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call taniff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Pusat informasi

ASC

Nomor layanan konsumen

BELARUS NA IBA +37517 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +3851 3330974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
;Egﬁf‘l\'Egl(\lEGRO NA Kim Tec d.o.o. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
U AN NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 /3 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara

Brazil

Argentina

Pusat informasi

Vermont

Nomor layanan konsumen

0800-7254101

0800 3330 856

Informasi kontak untuk China:

China

Nomor layanan konsumen: 4008 800 008

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi ASC Nomor layanan konsumen
USA. EPl-e-center Qwantech (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Informasi kontak untuk kawasan APMEA:

Pusat informasi Nomor layanan konsumen
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA smart Pixels Technology Ltd. | \p. -1\ Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
| Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ﬁz's Computer System Co. | 501 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276575
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA EZTmszr:'C‘Et!‘format'c +84 5113.562666 Danang City
pany =ie. +84 5113.562666 Can tho Province
T : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 10 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
& Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977.1-4229395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Mengatasi masalah & Tanya
jawab

8.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus
berlanjut setelah Anda mencoba solusi berikut,
hubungi staf layanan pelanggan Philips.

K Masalah Umum
Tidak Ada Gambar (LED Daya mati)

» Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.

» Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi

OFF (TIDAK AKTIF), lalu tekan ke posisi
ON (AKTIF).

Tidak Ada Gambar (LED Daya Putih)

» Pastikan komputer telah dihidupkan.

* Pastikan kabel sinyal telah tersambung
dengan benar ke komputer.

* Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

*  Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

» Pastikan kabel monitor telah tersambung
dengan benar ke komputer. (Lihat juga
Panduan Ringkas).

* Periksa pin yang tertekuk pada kabel
monitor.

» Pastikan komputer telah dihidupkan.

Tombol AUTO (OTOMATIS) tidak berfungsi

* Fungsi otomatis hanya berlaku dalam mode
Analog VGA. Jika hasilnya tidak memuaskan,
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Anda dapat melakukan penyesuaian manual
melalui menu OSD.

& Catatan

Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan api

* Jangan lakukan langkah-langkah apapun
untuk mengatasi masalah

* Lepaskan segera monitor dari catu daya
utama untuk keselamatan

* Hubungi segera staf layanan pelanggan Philips.
Bl Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi
“Auto” (Otomatis) dalam Kontrol Utama
OSD.

* Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya
berlaku dalam mode VGA.

Gambar bergetar di layar
Pastikan kabel sinyal telah tersambung dengan
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Kelip horizontal muncul di layar

=
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* Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.



* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

* Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan”
tetap muncul setelah daya dimatikan.

e Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan “efek terbakar”, disebut
juga “jejak gambar’ atau “bayangan”, di
layar. “Efek terbakar”, “jejak gambar”, atau
“bayangan” adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, “efek terbakar”, “jejak gambar”,
atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya

dimatikan.

* Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.

* Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten
statis yang tidak berubah.

* Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
Jaminan.

Gambar tampak berubah. Teks tidak jelas atau
buram.

* Aturresolusi layar PC ke mode sama seperti
resolusi asli layar yang disarankan monitor.

Titik hijau, merah, biru, hitam, dan putih muncul
di layar

» Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
dalam teknologi saat ini. Untuk informasi
lebih rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan
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mengganggu

* Anda dapat mengatur lampu “daya hidup”
menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat

Informasi Konsumen dan hubungi staf layanan

pelanggan Philips.

8.2 Tanya Jawab Umum

P1:  Sewaktu memasang monitor, apa
yang harus saya lakukan jika layar
menampilkan "Cannot display this video
mode" (Tidak dapat menampilkan mode
video ini)?

Jawab: Resolusi yang disarankan untuk monitor

ini: 1920 x 1080 pada 60Hz.

* Lepas semua kabel, lalu sambungkan PC ke
monitor yang digunakan sebelumnya.

* Dalam Windows Start Menu (Menu
Mulai Windows), pilih Settings/Control
Panel(Pengaturan/Panel Kontrol) . Dalam
Control Panel Window (Jendela Panel
Kontrol), pilih ikon Display (Tampilan).

Dalam Display Control Panel (Panel Kontrol
Tampilan), pilih tab "Settings" (Pengaturan).
Dalam tab pengaturan, dalam kotak "desktop
area" (area desktop), gerakkan panel samping
ke piksel 1920 x 1080

» Buka "Advanced Properties" (Properti
Lanjutan), atur Kecepatan Refresh ke 60Hz,
lalu klik OK.

* Hidupkan ulang komputer, lalu ulangi langkah
2 dan 3 untuk memverifikasi bahwa PC telah
diatur ke 1920 x 1080 pada 60Hz.

* Matikan komputer, lepas monitor lama, lalu

sambungkan monitor Philips.

Hidupkan monitor; lalu hidupkan PC.

P2:  Berapa kecepatan refresh yang
disarankan untuk Monitor?

Jawab: Kecepatan refresh yang disarankan
untuk Monitor adalah 60Hz. Jika
terdapat gangguan di layar, Anda
dapat mengaturnya hingga /5Hz untuk
mengetahui apakah gangguan tersebut
dapat diatasi.



P3:

Jawab:

P4:

Jawab:

P5:

Jawab:

Pé:

Jawab:

P7:

Jawab:

P8:

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM? Bagaimana
cara menginstal driver (.inf dan .icm)?

Ini adalah file driver untuk monitor.
Untuk menginstal driver, ikuti petunjuk
dalam panduan pengguna. Komputer
mungkin akan menanyakan driver
monitor (file .inf dan .icm) atau disk
driver saat Anda menginstal monitor
untuk pertama kalinya. lkuti petunjuk
tentang cara memasukkan CD-ROM
pendamping yang disertakan dalam
kemasan ini. Driver monitor (file .inf dan
.icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi
yang diinginkan dalam Panel Kontrol
Windows® dengan “Display properties”
(Properti tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK, lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali
semua pengaturan pabrik awal.

Apakah layar LCD antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara
membersihkan permukaan LCD?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol,
aseton, hexane, dll.

Apakah pengaturan warna pada
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Jawab:

monitor dapat diubah?

Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesuali
prosedur berikut,

* Tekan "OK" untuk menampilkan menu OSD
(On Screen Display)

* Tekan "Down Arrow" (Panah Bawah) untuk
menggunakan pilihan "Color" (Warna), lalu
tekan "OK" untuk membuka pengaturan
warna. Berikut adalah tiga pengaturan yang
tersedia.

1.

Color Temperature (Suhu Warna);

Dua pengaturan suhu wama adalah
6500K dan 9300K. Dengan pengaturan
dalam kisaran 6500K, panel menampilkan
"hangat dengan nada warna merah-putih”,
sedangkan suhu 9300K menghasilkan
"nada dingin, biru-putih",

sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran warna
yang benar di antara berbagai perangkat
(misalnya kamera digital, monitor, printer,
pemindai, dll.)

User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesual keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

& Catatan:

Penghitungan warna lampu yang dipancarkan
oleh benda tertentu sewaktu sedang dipanaskan.
Penghitungan ini diberikan dalam persyaratan
skala absolut, (derajat Kelvin). Suhu Kelvin lebih
rendah seperti 2004K berwarna merah; suhu
lebih tinggi seperti 9300K berwarna biru. Suhu
netral adalah putih pada 6504K.

P9:

Jawab:

Apakah Monitor dapat disambungkan
ke PC manapun, workstation, atau Mac!?

Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.



P10:

Jawab:

P11:

Jawab:

Apakah Monitor Philips memiliki fungsi
Plug-and-Play?

Ya. Monitor merupakan perangkat
Plug-and-Play yang kompatibel dengan
Windows /7/Windows 8/Vista/XP/NT,
Mac OSX, Linux

Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,
atau Bayangan pada panel LCD?

Tampilan gambar diam atau gambar
statis yang tidak berubah dalam

waktu lama dapat menimbulkan "efek
terbakar", disebut juga "jejak gambar"
atau "bayangan”, di layar. "Efek terbakar",
"lejak gambar", atau "bayangan" adalah
fenomena umum dalam teknologi panel
LCD. Dalam sebagian besar kasus, "efek
terbakar", "jejak gambar", atau "bayangan"
akan menghilang secara bertahap dalam
waktu tertentu setelah daya dimatikan.
Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan
monitor.

Aktifkan selalu aplikasi refresh layar
berkala jika Monitor akan menampilkan
konten statis yang tidak berubah.

(A Peringatan
Kegagalan mengaktifkan screensaver, atau aplikasi
refresh layar secara berkala dapat menyebabkan

gejala parah "efek terbakar", "jejak gambar", atau
bayangan gambar" yang tidak akan menghilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam jaminan

Anda.

P12:

Jawab:

Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter
bergerigi?

Monitor berfungsi paling baik pada
resolusi asli 1920 x 1080 @60Hz. Untuk
tampilan terbaik, gunakan resolusi ini.

35



PHILIPS

© 2012 Koninklijke Philips Electronics N.V. Semua Hak Dilindungi Undang-Undang.
Philips dan Philips Shield Emblem adalah merek dagang terdaftar dari Koninklijke

Philips Electronics N.V. dan digunakan berdasarkan lisensi dari Koninklijke Philips
Electronics N.V.

Spesifikasi dapat berubah sewaktu-waktu tanpa pemberitahuan sebelumnya.

Versi: M4226V4T



